List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Demo File Terminal Example</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Terminal Display</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>Portable Reader Sub-menu</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>Searching for Portable Reader</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>Portable Reader Connection Status</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>Portable Reader Parameters</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>List of Tag Sessions</td>
<td>8</td>
</tr>
<tr>
<td>8</td>
<td>Transferring Sessions Data Progress Message</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Portable Reader Data Track Selection</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>Cars Entered by the Portable Reader</td>
<td>9</td>
</tr>
<tr>
<td>11</td>
<td>Compare Track Tag Lists</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>Adding Comparison Vehicle Tags</td>
<td>11</td>
</tr>
<tr>
<td>13</td>
<td>Maintenance Codes</td>
<td>11</td>
</tr>
<tr>
<td>14</td>
<td>Added Maintenance Code</td>
<td>12</td>
</tr>
<tr>
<td>15</td>
<td>Shortcut Pop-up Menu</td>
<td>13</td>
</tr>
<tr>
<td>16</td>
<td>Memorized Search and Report Layout</td>
<td>14</td>
</tr>
<tr>
<td>17</td>
<td>Vehicle List Search Criteria</td>
<td>14</td>
</tr>
<tr>
<td>18</td>
<td>Vehicle List Display</td>
<td>16</td>
</tr>
<tr>
<td>19</td>
<td>Save Print Layout</td>
<td>17</td>
</tr>
<tr>
<td>20</td>
<td>Vehicle List Print Dialog</td>
<td>17</td>
</tr>
<tr>
<td>21</td>
<td>Export Dialog</td>
<td>19</td>
</tr>
<tr>
<td>22</td>
<td>Find a Vehicle Display</td>
<td>20</td>
</tr>
<tr>
<td>23</td>
<td>Find UMLER Data</td>
<td>22</td>
</tr>
</tbody>
</table>
1. INSTALLATION

1.1. Loading the Program
The Portable Reader Lite version of the AEI Rail & Road Manager is a 32-bit Windows program which will run on systems running Windows 95, Windows 98, or Windows NT 3.51 or later. It will not run under Windows 3.1.

The Portable Reader Lite program comes on a single 3.5” disk. To install the program, insert the disk into the floppy drive and click the Start and then the Run buttons. In the Open box, type a:setup if the disk was placed into Drive A or b:setup if the disk was placed into Drive B. Follow the instructions in the Setup program to complete the installation.

When the Portable Reader Lite program is installed, the Setup program will create a Portable folder and a Portable Reader Lite program.

1.2. Starting the Program
To start the program, click the Start button, point to Program and then to the Portable folder and click on the Portable Reader Lite program.

After starting the program, the Terminal Display appears (see Figure 1).

The first time the program is started this display will show a fictitious terminal that is typical of the type of terminal that could be designed and whose inventory could be maintained with the full AEI Rail and Road Manager program. This display is generated from a file called “demo.car”. A second file called “work.car” is used to store vehicle data entered into this program either via portable reader “reads” or manually by the user onto existing tracks. To see the data for this file click the Work File button near the top of the screen. The first time this button is clicked, the screen will be completely blank because data has not yet been entered. Once tag data has been transferred from the portable reader, it will be graphically represented on the screen as various types of vehicles on straight tracks. Only after tracks has been created due to portable reader input can vehicles be manually entered and placed on the existing tracks.

The user can view the demo data again at any time by clicking the Demo File button, but after the first execution of the program, the demo data will not automatically be shown when the program begins.
Figure 1 - Demo File Terminal Example

Figure 2 shows how data from tag reads will be represented after being transferred from the portable reader to the Portable Reader Lite program. When a transfer of tag data is complete, the program will ask that the vehicles be assigned to a track. Enter an alphanumeric (up to 20 characters) track name to create a new track. Once a name is entered the track will be drawn on the Terminal Display and the vehicles from the data transfer will be placed on it. See Paragraph 4 for more information about transferring tag data from the portable reader.
2. BRIEF OVERVIEW

The Portable Reader Lite program is the core version of our AEI Rail & Road Manager program. This version is included with every SmartScan Portable Reader. SmartScan Portable Reader owners who want to upgrade to the full version of AEI Rail & Road Manager will receive a special discount. Contact Signal Computer Consultants for more details.

AEI Rail and Road Manager is a low cost but robust and flexible software system designed for maintaining vehicle inventory in a small to moderate-size rail yard or road terminal. Operating within Windows, the system takes advantage of its graphical and multi-tasking capabilities to move easily between conventional vehicle information listings and graphic screen displays of vehicles arrayed in a terminal or yard.

Input of vehicle records, originally restricted to manual entry only, has been expanded to accept AEI tag data from the SmartScan Portable Reader, and (full version only) to interface to wayside AEI readers located in the terminal area. Once in the system, vehicle records can be modified, sorted, searched for and included in reports generated for yard or terminal management. Car lists and reports can be printed or exported for use in other data management systems.

Figure 2 - Terminal Display
Each record represents a vehicle in the system. Records may be viewed in standard column/row database listings and as individual vehicles arrayed on a graphic representation of a terminal or yard. A vehicle may be selected from a standard car list and immediately located on the terminal display, then picked up and moved to a new location (drag & drop) with the mouse. Similarly, a vehicle may be highlighted on the terminal display, and the complete record for that vehicle will come up on the screen.

All of these features and functions are included in this core version of AEI Rail & Road Manager, and are described in more detail in this manual. Additional functions found only in the full version of AEI Rail and Road Manager include:

- Building custom terminal layouts in addition to the standard layouts
- Defining and adding custom data fields
- Defining and using more than one vehicle database at a time
- Use in a network (multi-user capability)
- Capability to interface with wayside equipment & AEI readers
- Options to expand the size of a database beyond 500 vehicles

A set of two manuals is included with each portable reader. This manual, “Portable Reader Lite Quick Start Manual,” describes how to transfer tag data to the program and how to use the program’s basic functions. The second manual, “AEI Rail & Road Manager User Manual,” goes into more detail and covers all program functions.

3. TECHNICAL SUPPORT AND UPDATES

Periodically Signal Computer Consultants issues maintenance releases and new versions of this program. Maintenance releases are free and correct problems found with the program and/or provide minor enhancements to the program. Before contacting us with problems we suggest that you check our web page at www.signalcc.com to ensure that you have the latest maintenance release of the program. You can also go to our web page by clicking the appropriate web page item under the program’s Web Page menu at the top of the screen.

For technical support or more information contact Signal Computer Consultants at:

Signal Computer Consultants  
P.O. Box 18445  
Pittsburgh, PA  15236

Tel. 888 872-4612 (toll free US and Canada only) or 412 655-1884  
Fax. 412 655-1893  
E-mail signal@signalcc.com  
Web Page www.aeitag.com
Portable Reader Lite

4. PORTABLE READER

The system is designed to interface with the SmartScan Portable Reader. This hand-held RF reader can acquire and temporarily retain the data for more than a thousand AEI tag reads. The portable reader and a personal computer may be connected using a standard RS-232 serial communications interface. Once the communications link has been established, tag data collected by and stored in the portable reader can be transferred to Portable Reader Lite. All functions that can be performed on manually-entered vehicle information can also be done for tag data coming from a hand-held reader.

4.1. Establishing the SmartScan Portable Reader to Computer Interface

The portable reader comes with a communications cable terminated on one end by a serial connector (either 9 pin or 25 pin male connector). Connect this cable to a serial port on the back of the computer. The other end of the cable has an RJ-45 connector that fits the combined charging/communications port on the portable reader.

With the cable connected, turn on the portable reader. From the keyboard on the portable reader place the reader in “Host Transfer” mode, and then in “Host Initiated” mode. Once configured as “Host Initiated” the message “Waiting for Host...” appears on the portable reader's display. This message indicates the portable reader is ready to transfer data to the computer to which it is connected.

4.2. Establishing Communications between the Computer and the Portable Reader

Portable Reader Lite must activate the communications link with the portable reader before it can transfer tag data. From the computer keyboard select the Portable Reader menu item (see Figure 3). The last item displayed on the sub-menu is “Search for a Portable Reader.” Click on this item to initiate the search. The four communication ports (COM M1 to COM M4) are scanned to locate the Portable Reader connection. During the search the message shown in Figure 4 is displayed.

![Figure 3 - Portable Reader Sub-menu](image)

![Figure 4 - Searching for Portable Reader](image)
Portable Reader Lite

If a portable reader is found on one of the communication ports, the system will continue to scan the other ports to see if another portable reader is connected.

If more than one portable reader is connected, the system will ask that all but one of the portable readers be disconnected.

After the system has scanned all of the communication ports, the status of the ports will be displayed (see Figure 5).

![Portable Reader Connection Status](image1)

**Figure 5 - Portable Reader Connection Status**

Figure 5 shows the status of each port and which port is connected to the portable reader.

If the user clicks the Refresh button on this dialog, the system will start a new search for a portable reader.

Clicking on the Portable Reader Parameters button will cause the display in Figure 6 to appear, which shows the portable reader’s internal parameters.

![Portable Reader Parameters](image2)

**Figure 6 - Portable Reader Parameters**
Portable Reader Lite

This display (Figure 6) can also be shown by selecting the Read Portable Reader Parameters item under the Portable Reader menu (see Figure 3).

4.2.1. Problems Connecting with the Portable Reader
If a portable reader is not found check the following:

- Make sure there is a good cable connection between the portable reader and the computer
- Make sure the cable is plugged into one of the communication ports (9 or 25 pin connector on the back of the computer)
- Make sure the portable reader is in the Host Transfer/Host Initiated mode (the portable reader is displaying the “Waiting for Host...” message).

If the portable reader is still not found, try another 9 or 25 pin connector on the back of your computer.

If the portable reader continues to not be found, check the display in Figure 5 to see if there are any active ports. If no ports are active check the computer manual on how to activate a communication port.

If you continue to have problems, contact us by telephone at 412 655-1884. When you call please be at your computer with Figure 5 displayed.

4.2.2. Transferring Tag Data from the Portable Reader
Transferring tag data from the portable reader to your computer is a two step process. The first step is to read and display headers for all of the tag sessions stored in the portable reader.

A tag session is a group of tag reads stored together. For example, the tags on all the vehicles on one track may be read in one session, and the vehicles on the next track may be read and stored together in a second session. The operator of the portable reader will determine when one session ends and the next begins. The portable reader can store up to 99 sessions.

To display a list of all of the stored tag sessions select the Read Tag Sessions item under the Portable Reader menu (see Figure 3). A message will appear which shows the progress in transferring the session headers from the portable reader to the computer. Once all of the session headers are transferred a list of the tag sessions as shown in Figure 7 will be displayed.
Figure 7 - List of Tag Sessions

For each tag session this list shows the tag session number, the date and time the tags in the session were stored in the portable reader, the number of tags stored for the session, the vehicle ID of the first tag stored in the session, and the ID of the portable reader in which the session data is stored.

Select a session by placing the mouse cursor on the session and clicking the left mouse button. Multiple sessions can be selected for transferring at the same time.

To transfer the actual tag data in the selected session(s), click the Read Selected Sessions’ Tags button. The system will show the progress in transferring the data by displaying the message in Figure 8.

Figure 8 - Transferring Sessions Data Progress Message

Once all of the data for a given session is transferred the dialog in Figure 9 will be displayed.
The dialog in Figure 9 allows the user to select the track to which the sessions’ tags will be added or compared with existing vehicles. The selected track can be an existing track already displayed or a new track. Any alphanumeric name up to 20 characters long can be assigned to a new track.

Tracks defined by the user will continue to be displayed as long as there are rail vehicles on them. When there no longer are any vehicles on a track, it will be erased the next time the AEI Rail & Road Manager program is started.

In Figure 9 we have specified that the vehicles in the session will replace the cars on a track called “portable”. The result of this action can be seen in Figure 10.

In Figure 10, 14 rail vehicles are shown on a track called “portable”. There were, however, 15 tags read in this session. In this case one of the tags (ICG531348) was read twice. Even though the tag was read twice, the vehicle will only appear once on the track.

Portable Reader Lite has the capability of maintaining a sub-set of UMLER in its database. If your system has the UMLER subset installed, when a vehicle is entered into the Portable Reader Lite’s database the system will search UMLER to find a record on the vehicle to determine the type of vehicle and then display the appropriate vehicle type on the Terminal Display. For more information about using the UMLER database subset see Paragraph 10.
The user also has the option (see Figure 9) of adding the session's vehicles to the left or right of a cut of rail vehicles already on a track or comparing the session's tags with the vehicles already on the track.

Each rail car has two AEI tags, one on each side of the rail car. By comparing the tags on one side of a cut of rail vehicles to the tags on the other side of the cut, missing or non-functioning tags can be identified. The general procedure is for an individual to start a new tag session, then read tags with the portable reader down one side of a cut of rail vehicles. After the last vehicle in the cut is read, the operator starts another session and begins reading tags down the other side of the cut. It is not necessary for the new session to begin with the same vehicle as the first session; the tags in the new session may be read in reverse order allowing the individual to merely step around the last car in the cut and start reading down the other side.

The first session's tags are then transferred and added to a track. The second session's tags are then transferred and compared with the vehicles already on the track. The result of such a comparison can be seen in Figure 11.

In Figure 11 the vehicle tags on the left are from the first session and were added to the track. In the graphic above they are being compared with tags from the second session, which appear on the right. If a vehicle tag on the left does not have a corresponding vehicle tag on the right, the tag on the second session's side of the vehicle is either missing or bad. This would be true, for example, for Tag ICG 531348 in Figure 11. If a tag exists in the right side of the list box and does not have a corresponding tag in the left side, it can be assumed a tag is missing or bad from the side of the vehicle that was originally read and which determined the vehicles that were placed on the track. This would be true for Vehicle Numbers CSX009987, NS034526, NS054773 and DRLX050074.
To add these vehicles to the track, the user would click the Add Compare Tags button. This adds the vehicle tags on the right side of the list box that do not have a corresponding vehicle tag on the left side of the list box to the track and places them in the appropriate position.

![Figure 12 - Adding Comparison Vehicle Tags](image)

In Figure 12 above the four vehicles that were in the comparison session list of tags and not already on the track have now been added to the track called “portable”.

4.2.3. Portable Reader Maintenance Code

When the portable reader reads vehicle tags, a two-digit maintenance code can be appended to the tag data by the portable reader’s operator. This maintenance code will also be transferred to the Portable Reader Lite program with the tag data.

The portable reader maintains a list of maintenance code descriptions that can be transferred to this system. To transfer the maintenance code descriptions, select the Read Maintenance Code item under the Portable Reader menu. This will cause the dialog in Figure 13 to be displayed.

![Figure 13 - Maintenance Codes](image)
The list box in Figure 13 shows the two-digit code number, the description, and by whom the maintenance code was defined. Users can add their own maintenance code descriptions to numbers that are not already used by the portable reader.

To add a new or change an existing description, select the code in the list (by placing the mouse cursor on the code number and clicking the left mouse button) then type the new description in the Description field and click the Change button. Figure 14 shows the “Brake Hose” description added as Maintenance Code 35.

5. TRACK/ROAD SHORTCUT FUNCTIONS

The system provides an easy shortcut method for exporting, listing, printing, reversing inventory or deleting vehicles on a track. To implement one of these shortcut functions, place the mouse cursor on the track for which you want to perform one of these functions and click the right mouse button. The pop-up menu in Figure 15 will appear.
Click the appropriate item to begin the dialog for a function. The functions themselves are described in the paragraphs listed below:

- Exporting Track Inventory - Paragraph 7
- Listing Track Inventory - Paragraph 6.2
- Printing Track Inventory - Paragraph 6.6
- Reversing Track Inventory - Paragraph 8
- Deleting Track Inventory - Paragraph 9.2

6. VEHICLE LIST DISPLAY

The Vehicle List display shows a list of all vehicles meeting a user’s search criteria. All fields associated with a vehicle are included in the Vehicle List display.

6.1. Vehicle List Search Criteria

To display the Vehicle List, click the Vehicle List button on the tool bar. The Memorized Search and Report Layout dialog (see Figure 16) will first appear. The user can specify if he or she wants to use a New, the Last, or a previously saved search criteria. The user can also display the last vehicle search criteria that was entered by clicking the Last List button on the tool bar.
The next screen used in the search sequence is shown in Figure 17. At any time the user can return to the Terminal Display by clicking the Terminal button on the tool bar.

The user enters, on this display, the search algorithms for the vehicle list. With a few exceptions these algorithms operate in the same fashion as the user algorithms in the Vehicle Color and Status Line displays which are explained in the AEI Rail and Road Manager manual.
A time search can find all the vehicles that have either entered the terminal or left the terminal during a specified span of time. The possible contents of the Time field are either “Time in” or “Time out”. The user can specify a range of times in the From and To fields. A specific date and time can be entered into these fields or the number of hours or days before the current time. The To field also allows “now” to be entered to specify the current date and time.

If a user enters a specific date but no time, 12:00 AM will be assumed in the From field and 11:59 PM in the To field. If the year is not included, the current year is assumed.

If there is no entry in the From field, no comparison against time will be made. If there is an entry in the From field, but not in the To field, the To field is assumed be 24 hours after the value in the From field.

There are four search fields in the Vehicle Search Criteria display. With one exception these fields are logically ANDed. This means that the vehicle must meet all of the user defined algorithms to be included in the Vehicle List display. Not meeting one algorithm’s criteria will prevent the vehicle from being included. There is only one exception to this rule. This exception is when the same field appears in more than one algorithm with an “Equal to” comparison. In this case the algorithms using the same field in the “Equal to” comparison will be logically ORed. If a vehicle meets only one of these algorithms’ criteria, the vehicle will be included. For example, if a user has an algorithm with the Status field equal to “empty” and an algorithm with the Status field equal to “bad order”, any vehicle having one of these two values in its Status field will be listed.

The vehicles’ Comments fields can be searched for a sequence of alpha/numeric characters of up to 30 characters in length. If the user enters a sequence of characters in this field all Comments fields will be searched and vehicles containing this sequence will be displayed. The sequence of characters being searched for can exist anywhere in the Comments field.

The user can require this search to be case sensitive. If the Case Sensitive box is checked, broken will not be considered equivalent to Broken in the comparison tests.

By checking the All Comments box, all vehicles that have comments will be included in this list.

By default the system always sorts the vehicle list by vehicle number in ascending order. In addition, the user can specify up to three sort fields. Each of these three fields can be independently sorted in ascending or descending order. The user selects the order by clicking the button on the right side of the Sort Order box (first box under each Sort Field), and clicking the appropriate entry.

Below the Sort Order box is a box for the field that is to be sorted. The user clicks the button on the right side of this box to select the appropriate field to be sorted. Sort Field 1 is the highest sort level and Sort Field 3 the lowest.

To display the Vehicle List the user would then click the OK button. By clicking the Cancel button the last vehicle list would be displayed.

If the user clicks the OK button and if changes have been made to the search criteria, the system will ask if the user wants to save the search criteria and give it a name so that it can be later retrieved.

6.2. Vehicle List Display
The Vehicle List display is shown in Figure 18. The total number of vehicles found in the search is shown on the status line under the tool bar. Below the status line and a set of user buttons are the column headers followed by a list of vehicles meeting the search criteria.
The user can adjust the width of the columns in this display. Place the mouse pointer on the vertical line between two column headers (for example, on the line between the Vehicle ID and Location column headers), depress the left mouse key, and drag the mouse to the left or right to resize the columns.

To save the new column sizes, click the Save Column Widths button above the column headers. The next time this display is accessed it will have the same column widths that were displayed when the Save Column Widths button was clicked.

6.3. Finding a Vehicle on the Terminal Display

From the Vehicle List display a vehicle can be found on the Terminal display. First, select the vehicle to be found by placing the mouse pointer on the Vehicle ID of that vehicle and clicking the left mouse button. This will highlight the vehicle’s ID. Then click the Find Vehicle button above the column headers. The program will then show the Terminal Display and place the mouse pointer on the vehicle.

6.4. Vehicle Information Display

The user can show the Vehicle Information display for any vehicle in the Vehicle List by placing the mouse pointer on the Vehicle ID of that vehicle and clicking the left mouse button. This will highlight the vehicle’s ID. Then click the Change Vehicle Data button above the column headers. The program will then show the Vehicle Information display.

6.5. Vehicle Comments

Because comments placed in a vehicle’s Comments field can be lengthy, they are not displayed in the Vehicle List display. To display the comments for a particular vehicle select the vehicle by placing the mouse pointer on the Vehicle ID of that vehicle and clicking the left mouse button. This will highlight the vehicle’s ID. Then click the See Comments button above the column headers. The program will then display the comments associated with the selected vehicle.

6.6. Printing the Vehicle List

When the Vehicle List display is on the screen the user can print this information by choosing the Print menu item under the File menu. This choice causes the screen in Figure 19 to be displayed.

Once New, Last or a previously saved print layout is selected, Figure 20 will appear.
The system provides the user a great deal of flexibility in printing reports. The user can specify the report title, if the line numbers and date are to be included, which fields should be in the report and in what order, the fonts used for the title, column headings and body, and the printer setup.

The vehicle records included in the report will be the same records displayed in the Vehicle List on the screen. This allows the Vehicle List Search Criteria to be used to determine which vehicles will be shown on the report.
The user determines the fields that will be included in the report by placing the cursor on the field name in the left-hand list of Available Fields and clicking the left mouse button. This causes the field to be highlighted. The user then clicks the Add button. The field will then be moved to the Selected Print Fields list. Multiple fields can be selected by pointing the cursor to each field and holding the control key down while clicking the left mouse button.

To remove fields from the Selected Print Fields list, select the fields to be removed and click the Remove button.

The fields in the Selected Print Fields list are in the same order they will appear in the report. The top field in the list will be in the left-most column in the report. Each field down the list will be in the column to the right of the previous field in the list. To change the order of the fields in the report, select the fields you want to be closer to the left side of the report and click the Advance button.

By clicking the Preview button on the right side of the dialog box, the report can be viewed prior to printing.

6.7. Listing or Printing a Single Track/Road’s Vehicle Inventory

The program has a shortcut method for generating a list or printing a list of vehicles on a single track/road. To start this shortcut place the mouse cursor on the appropriate track/road and click the right mouse button. This causes a popup menu shown in Figure 15 to appear. Select the appropriate item to start the process.

7. EXPORT DATA

To provide maximum flexibility, the system has the capability to create an export file for the vehicle records. This is a text file with the fields delimited by a character the user can choose. The user can also choose which fields will be included in each export record. With this capability the information in the system can be easily transferred to various commercial word processing, spreadsheet or database programs or to user written programs allowing the user to generate special reports and perform statistical analyses.

By choosing the Export menu item under the File menu the Export Fields dialog will appear, and the user will be asked for the Export file name.

7.1. Export Dialog

Once the name is entered Figure 21 will appear. The user can specify a one-character delimiter (usually a comma or a space) which will be placed between each field in the records. The user can also specify if the first record of the file will contain the names of the fields in the order they appear in each of the vehicle records to be exported. The last option before selecting the fields to be included in the export record concerns whether all of the vehicles’ records will be included in the export file, or just the ones found in the last Vehicle List Search.
The user then selects the fields to be included in each vehicle’s export record as was done with the Print Dialog described in Paragraph 6.6. The user determines what fields will be included in each export record by placing the cursor on the field name in the left hand list of Available Fields and clicking the left mouse button. This causes the field to be highlighted. The user then clicks the Add button, which moves it to the Selected Export Fields list. Multiple fields can be selected by pointing the cursor at each field and holding the Control key down while clicking the left mouse button.

To remove fields from the Selected Export Fields list, select the field to be removed and click the Remove button.

The fields in the Selected Export Fields list are in the order in which they will be listed in each export vehicle record. The top field in the list will be the first field. Each field down the list will be the next field in the export record. To change the order of the fields in the export record, select the fields you want to be closer to the beginning of the record and click the Advance button. The fields that were selected will move one position up in the list or one field closer to the beginning of the record. You can advance any field to the top of the list and advance multiple selected fields as a group.

8. REVERSE A TRACK’S INVENTORY
To reverse the order in which vehicles are displayed on a track (flip a track’s inventory making the left most vehicle, the right most vehicle), place the mouse cursor on the track to be reversed and click the right mouse button. This will cause a pop-up menu (see Figure 15) to display. Click the Reverse Track Consist item to flip the track’s inventory.
9. ADD, DELETE OR FIND A VEHICLE

9.1. Manually Adding, Deleting or Finding a Vehicle
The user can manually add vehicles to the system by clicking the Add Vehicle button in the tool bar near the top of the display. Only vehicle numbers that are not already in the system can be added.

9.2. Manually Deleting a Vehicle
Vehicles can be deleted by clicking the Delete Vehicle button on the tool bar. The user is shown a list of all vehicles in the system sorted in alphanumeric ascending order. The user then selects the vehicle that is to be deleted from this list.

All vehicles on a given track can be deleted with one manual operation. To start this shortcut place the mouse cursor on the appropriate track/road and click the right mouse button. This causes the popup menu shown in Figure 15 to appear. Select the appropriate item to delete all vehicles on the track.

9.3. Finding a Vehicle
To find a vehicle, click the Find Vehicle button on the tool bar. A list of all vehicles in the system will appear (see Figure 22). Select the vehicle from the list. Once the vehicle has been selected from the list, the cursor will be placed on the vehicle in the Terminal Display and a blue rectangle will appear around the vehicle’s number indicating that it has been selected. The system will automatically scroll to the appropriate place on the Terminal Display to show the found vehicle.

Figure 22 - Find a Vehicle Display
10. UMLER DATABASE
The Association of American Railroads maintains a rail equipment database called UMLER (Universal Machine Language Equipment Register). AEI Rail & Road Manager is designed to maintain a subset of the UMLER database. This subset consists of the following items for all vehicles registered in UMLER:

- Vehicle type
- Coupler to coupler length
- Number of axles
- Bearing code
- Number of platforms
- Tare weight
- Capacity weight

When vehicles are entered into this program’s database either by manual entry or by a tag read from a wayside or portable reader, the system can automatically search an installed UMLER database to find a record on the vehicle. If a record is found, this information is used to display the appropriate type of vehicle on the Terminal Display. Users can also view all of the other UMLER data items for a vehicle by calling up the Vehicle Information display (refer to AEI Rail & Road Manager User manual).

For the system to use UMLER, the UMLER database subset must be loaded from a CD available from Signal Computer Consultants. Because UMLER is constantly being updated, Signal Computer Consultant’s plans to create a new UMLER CD each month and distribute to customers on a subscription basis. To obtain more information about this service, contact Signal Computer Consultants.

10.1. Loading the UMLER Database from a CD
To load the UMLER data, insert the UMLER Database CD into the CD drive and select the Load UMLER CD Data item from the File menu. Opening the file “Umler.txt” on the CD expands and transfers the database to the hard drive.

10.2. Searching for Vehicle UMLER Data
The system allows users to search the internal UMLER database subset for a particular vehicle. To find the UMLER data select, the Find UMLER Data item under the Tools menu, enter a vehicle initial and number in the dialog, and click the Find button. If the vehicle record is found, the data will be displayed as shown in Figure 23.
Figure 23 - Find UMLER Data

The UMLER Data Specification Manual provides detailed information on these data items. This manual can be obtained from the Association of American Railroads at www.aar.org.
Index

add a vehicle.........................................................See vehicle, add
delete a vehicle...............................................See vehicle, delete
demostration file ..................................................1
Export
  shortcut...........................................................................12
Export dialog..............................................................18
field
  Comments ............................................................15
  Status ..............................................................................15
find a vehicle ............................................................See vehicle, find
installation ........................................................................1
maintenance codes
  portable reader ..........................................................11
Memorized Search and Report Layout dialog ...........13
portable reader
  maintenance codes ...................................................11
  parameters ...............................................................6
  problems reading ....................................................7
  reading tag data .......................................................7
  tag comparisons .....................................................10
  tag sessions ............................................................8
print
  vehicle list .............................................................12, 16
problems reading portable reader .See portable reader,
problems reading
reverse track inventory..............................................19
reversing track inventory..........................................12
shortcuts.............................................................................12
sort
  vehicle list .............................................................15
starting the program ..................................................1
Technical Support ......................................................4
Terminal display .........................................................14
UMLER
  Data Specification Manual ........................................22
  Database ......................................................................21
  Loading Database ...................................................21
  Searching for vehicles .............................................21
  vehicle
    add ........................................................................20
    add from portable reader ......................................7
    delete .......................................................................12, 20
    delete all cars on a track ......................................12
    find .........................................................................20
  Vehicle Information display .......................................16
  Vehicle List display ..................................................13, 15
  Vehicle List Search dialog ..........................................18
  Vehicle Search Criteria display ....................................15
  VehicleList display ...................................................12
Web Page
  Association of American Railroads .........................22
  Signal Computer Consultants .................................4
work file ...........................................................................1